Enhancing Excel Skills in Teaching Undergraduates in Busin

Xin James He
Fairfield University

Follow this and additional works at: https://scholarworks.lib.csusb.edu/ciima

Recommended Citation
Available at: https://scholarworks.lib.csusb.edu/ciima/vol11/iss4/2

This Article is brought to you for free and open access by CSUSB ScholarWorks. It has been accepted for inclusion in Communications of the IIMA by an authorized editor of CSUSB ScholarWorks. For more information, please contact scholarworks@csusb.edu.
Enhancing Excel Skills in Teaching Undergraduates in Business

Xin James He
Fairfield University, USA
xhe@fairfield.edu

ABSTRACT

This paper tries to enhance Excel skills in teaching an undergraduate operations management course since improving basic Excel skills is one of the key areas necessary to close the feedback loop. As a required core business course, OM101 Operations Management is a natural starting point to enhance basic Excel skills along with quantitative analysis and modeling skills. In light of overwhelming topics to be covered in the course, we believe it is best to enhance basic Excel skills by means of homework assignments with specific Excel instructions, instead of overburdening the students with extra Excel lectures or general-purpose Excel instructions.

Keywords: Enhancing Excel skills, teaching business undergraduate, technology

INTRODUCTION

The Dolan School of Business at Fairfield University (DSB), like many other universities, does not require incoming freshmen to take a proficiency test or an introduction class of basic Excel skills under the assumption that their basic skills are already adequate from high school and will be further improved by the time when they graduate from college. However, feedbacks from the Continuous Improvement Assessment Committee (CIAC) of the DSB and from the DSB Advisory Board indicate that improving basic Excel skills is one of the key areas necessary to close the feedback loop. In other words, efforts have to be made to enhance their basic Excel skills (e.g., spreadsheet organization, formulas & functions, cell relationships, graphics, and advanced functions) during their early years in college so that they can be better prepared for more advanced business courses and become more competitive in real business world after graduation. OM101 Operations Management as a required undergraduate business core course is a natural starting point to enhance basic Excel skills. While we encourage students to use Excel for homework assignments along with other business applications in the subject area, we often encounter technical difficulties due to uneven Excel skill levels and overwhelming subject topics to be covered in the operations management class. Moreover, most textbooks currently available in operations management (e.g., Collier & Evans, 2011-2012; Jacobs & Chase, 2011;) do not provide detailed Excel related instructions for homework problems, and most commercially available Excel instructions (e.g., Walkenbach, 2010) are too general to attract student attention. In this paper, we try to enhance basic Excel skills in teaching OM101 class by selecting appropriate homework problems that are relevant to basic Excel skills and by providing problem-specific Excel instructions to facilitate student learning.
This paper is organized as follows. Section 2 discusses problem selection. Section 3 illustrates problem-specific Excel instructions. Section 4 depicts implementation and learning outcomes. Section 5 summarizes the paper.

**PROBLEM SELECTION**

In light of overwhelming required subject topics to be covered in OM101 and lack of Excel related instructions with the currently available operations management textbooks, we believe the best way to enhance basic Excel skills in this teaching innovation project is to develop problem-specific Excel instructions for selected homework problems, instead of using general purpose Excel instructions.

Appropriate subject topics within the current textbook (Jacobs & Chase, 2011) are carefully selected so that a variety of basic Excel skills in the OM101 class will be included. Such topics as break-even analysis, forecasting, and inventory management are good candidates for initial experiment and implementation. More advance topics are to be included later on.

Homework problems relevant to such basic Excel skills as data input, analysis, calculation (formulas & functions), and simulation are potential candidates here. Specifically we focus our initial attention on data input (spreadsheet organization), formatting, basic formulas and functions, self-defined functions (cell relationships), chart building, and data analysis (advanced functions) skills that are essential to business students or specified by the CIAC as core technological competencies.

**EXCEL INSTRUCTIONS**

Sample problem-specific Excel instructions are illustrated in this section. With a variety of different problems associated with carefully selected subject topics in OM101, we try to develop user-friendly problem-specific instructions, which are designed for students with different Excel background. A forecasting problem from Chapter 15 (Jacobs & Chase, 2011), for example, is to demonstrate how we enhance basic Excel skills via problem-specific Excel instructions.

**Sample Problem**

Problem 2 (Ch. 15) Historical demand for a product is (Jacobs & Chase, 2011, p.518)

<table>
<thead>
<tr>
<th>Month</th>
<th>Demand (A_t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>12</td>
</tr>
<tr>
<td>February</td>
<td>11</td>
</tr>
<tr>
<td>March</td>
<td>15</td>
</tr>
<tr>
<td>April</td>
<td>12</td>
</tr>
<tr>
<td>May</td>
<td>16</td>
</tr>
<tr>
<td>June</td>
<td>15</td>
</tr>
</tbody>
</table>

Table 1. Sample Data Set.
Part a is to find the forecast for the month of July using a simple 3-month moving average, \( F_{July} = (A_{April} + A_{May} + A_{June})/3 \), where \( F_{July} \) is the forecast for the month of July, \( A_{April} \) is the actual demand for the month of April, \( A_{May} \) is the actual demand for the month of May, and \( A_{June} \) is the actual demand for the month of June.

Part b is to calculate the forecast for the month of July using a different forecasting technique - simple exponential smoothing, given \( \alpha = 0.2 \) and \( F_{June} = 13 \), \( F_{July} = F_{June} + \alpha (A_{June} - F_{June}) \), where \( \alpha \) is the smoothing constant.

Part c is to compute the slope, \( b \), and the y intercept, \( a \), of a simple linear regression model, and then to forecast the demand for the month of July (\( x=7 \)):

\[
\begin{align*}
y &= a + bx \\
b &= \frac{\sum xy - n\bar{y}\bar{x}}{\sum x^2 - n\bar{x}^2} \\
a &= \bar{y} - b\bar{x}
\end{align*}
\]

where \( n = 6 \) is the number of observations, and \( \bar{x}, \bar{y}, xy, \) and \( x^2 \) are shown in Table 2.

<table>
<thead>
<tr>
<th>Month (X)</th>
<th>Demand (Y)</th>
<th>XY</th>
<th>X²</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>12</td>
<td>12</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>11</td>
<td>22</td>
<td>4</td>
</tr>
<tr>
<td>3</td>
<td>15</td>
<td>45</td>
<td>9</td>
</tr>
<tr>
<td>4</td>
<td>12</td>
<td>48</td>
<td>16</td>
</tr>
<tr>
<td>5</td>
<td>16</td>
<td>80</td>
<td>25</td>
</tr>
<tr>
<td>6</td>
<td>15</td>
<td>90</td>
<td>36</td>
</tr>
<tr>
<td>( \bar{x} = 21/6 = 3.5 )</td>
<td>( \bar{y} = 81/6 = 13.5 )</td>
<td>( xy = 297 )</td>
<td>( x^2 = 91 )</td>
</tr>
</tbody>
</table>

Table 2. Sample Data Set for Linear Regression Analysis Sample.

Sample Instructions: There are a total of 12 basic Excel skills related to this sample problem, with four steps.

Step 1: Create the Sample Data Set as in Table 1.
1) Basic Skill 1—Cell Merge and Underline Table Title
Type the table title Data in cell A1
Highlight cells A1 through F1
Click the Merge & Center in the top toolbar (pictured below)
Click cell A1 and create border underline using the icon shown below:

2) Basic Skill 2 – Underline Column Titles

Type the column title “Month” in cell B3
Type the column title “Demand” in cell C3
To underline column titles, highlight cells A3 through C3 and click icon shown below:

3) Basic Skill 3 – Auto-fill the Months

Type the first month “January” in cell B4
Click cell B4 and hover mouse over the bottom right corner until a bold cross appears
Click and drag down from cell B4 to cell B9 to auto-fill the months “February – June”
Type the demand data in column B from cells C4 – C9 shown below:
Step 2: Solve Part a of the forecast for the month of July using a 3-month moving average

4) Basic Skill 4—Use the “Average” Function

In cell A13, type “Moving average for July = Average for April, May and June”
In cell A15, type “F\text{July} =”
In cell B15, type “=AVERAGE (C7:C9)” to calculate the moving average (The equal sign “=” in front of a function is necessary)

Step 3: Solve Part b of the forecast for the month of July using a simple exponential smoothing

5) Basic Skill 5—Insert Greek Symbol “α”

In cell A17, type “F_{\text{July}} = F_{\text{June}} + \alpha (A_{\text{June}} - F_{\text{June}})”
To insert the Greek Symbol “α”, go to the Insert Tab and click the Symbol box shown below:

To find the proper character, go to the character code box, type “03B1” (shown below), and press Insert
6) Basic Skill 6 – Use Self-defined Formula (Other self-defined formulas can also be developed by typing appropriate mathematic expression after the equal sign “=”).

In cell A19, type “F June”
In cell C19, type “13”
In cell A20, insert Greek Symbol “α =” using the steps described above
In cell C20, type “0.2”
In cell A22, type “F July =”
In cell B22, type the self-defined formula “= C19 + C20*(C9 - C19)” (The equal sign “=” in front of any self-defined function is necessary)

Step 4: Solve Part c of simple linear regression and forecast for the month July

7) Basic Skill 7 – Use Auto-fill for Sequential Numbers

In cell A24, type “Linear Regression: y = a – bx”
In cell B26, type “x”
In cell C26, type “y”
In cell D26, type “xy”
In cell E26, type “x²”
Type the first number “1” in cell B27 and the second number “2” in cell B28
Click cells B27-B28 and hover mouse over the bottom right corner until a bold cross appears

Click and drag from cells B27-B28 to B32 to auto-fill the sequential numbers “3 – 6”: 
8) **Basic Skill 8 – Copy a Value from One Cell to Another**

In cell C27, type “=C4” to copy the value in C4 into C27
Click on cell C27 and hover mouse over the bottom right corner until a bold cross appears.
Click and drag down to cell C32 (values in C5-C9 will be copied to C28-C32)

9) **Basic Skill 9 – Use Excel as a Spreadsheet for Regression (as opposed to built-in Regression function as shown in Basic Skills 11 and 12)**

In cell D27, type the x*y as “= B27*C27”
Copy the formula in D27 into D28-D32 using steps described above
In cell E27, type $x^2$ as “= B27^2”
Copy the formula in E27 into E28-E32
In cell B33, type the total in column “= SUM (B27:B32)” to calculate the sum of x
Copy formula from cell B33 to cells C33-E33
In cell A35, type “Mean”
In cell B35, type “= AVERAGE (B27:B32)” to calculate the mean of x
In cell C35, type “= AVERAGE (C27:C32)” to calculate the average of y
**Now we have $\bar{x}$ in cell B35, $\bar{y}$ in C35, $\bar{xy}$ in D33, and $\bar{x}^2$ in E33**

In cell A37, type “b =”
Type the formula for slope b in cell D37 as “= (D33 – 6*B35*C35)/(E33 – 6*B35^2)”
In cell D39, type “a =”
Type the formula for y-intercept a in cell D39 as “= C35 – D37*B35”
Type “The regression model is y = 10.8 + .77 x” in cell A41
In cell A43, type “y(7)=”
To forecast for July, type the formula in cell D43, “= D39+ (D39*7)” in D43:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
<td>y</td>
<td>xy</td>
</tr>
<tr>
<td>25</td>
<td>Linear Regression: y = a - bx</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>1</td>
<td>12</td>
<td>12</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>2</td>
<td>11</td>
<td>22</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>3</td>
<td>15</td>
<td>45</td>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>4</td>
<td>12</td>
<td>48</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>5</td>
<td>16</td>
<td>80</td>
<td>25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>6</td>
<td>15</td>
<td>90</td>
<td>36</td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>21</td>
<td>81</td>
<td>297</td>
<td>91</td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Mean</td>
<td>3.5</td>
<td>13.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>b</td>
<td>0.771429</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>a</td>
<td>10.8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>The regression model is y = 10.8 + .77 x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>y(7)</td>
<td>16.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

10) **Basic Skill 10 - Build Scatter Diagram with Trend Line and Regression Equation**

Re-create the Sample Data Set of Table 1 in cells A57 through B65:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>57</td>
<td></td>
<td></td>
</tr>
<tr>
<td>58</td>
<td>x</td>
<td>y</td>
</tr>
<tr>
<td>59</td>
<td>1</td>
<td>12</td>
</tr>
<tr>
<td>60</td>
<td>2</td>
<td>11</td>
</tr>
<tr>
<td>61</td>
<td>3</td>
<td>15</td>
</tr>
<tr>
<td>62</td>
<td>4</td>
<td>12</td>
</tr>
<tr>
<td>63</td>
<td>5</td>
<td>16</td>
</tr>
<tr>
<td>64</td>
<td>6</td>
<td>15</td>
</tr>
</tbody>
</table>

Highlight cells A60-B65
Select the “Insert” tab shown below:
Select “Scatter” tab shown below:

Select the “Layout” tab shown below:

Select the “Linear Trendline” tab shown below:
Now we have the Scatter Diagram with a trend line:

To display the regression equation on the chart, right click on any of the dots on the Scatter Diagram:
Select “Add Trendline” in the dialogue box below:

Check the box that says “Display Equation on chart” box:
Now we have the Scatter Diagram with regression equation:

\[ y = 0.7714x + 10.8 \]

11) Basic Skill 11 – Install “Data Analysis add-in” for Regression

To install “Data Analysis add-in,” click on the icon “File” (shown below):
Click on “Options” shown below:

Click on “Add-Ins” shown below:
Select “Excel Add-ins” and click Go
Select “Analysis ToolPak” and click OK.

12) **Basic Skill 12 – Use Data Analysis for Regression**

Click the “Data” tab on the ribbon:

Select “Data Analysis”:

Select “Regression” and click OK:
Fill the Regression dialogue box as shown below:

Please note that the checked dialogue box “Labels” in red is to tell Excel that the data set contains a row of labels (e.g., the cell B59 contains the label “y” and cell A59 the label “x”). However, in case there are no labels included in the data set, the “Labels” dialogue box should not be checked. If the “Labels” box is incorrectly checked, the entire analysis will be invalid!

This will create the following regress analysis table:
IMPLEMENTATION AND LEARNING OUTCOMES

We implemented problem-specific Excel instructions for selective homework problems for OM101 in Fall 2011, with partial implementation in Spring 2011. For the purpose of comparison, we tried three different ways, as shown in Table 3: i) Excel was required to do certain homework problems—students were instructed to use commercially available Excel instructions or built-in help menus, but no problem-specific Excel instructions were available; ii) Excel was optional to do certain homework problems—students were instructed to use problem-specific instructions; and iii) Excel was required to do certain homework problems—students were instructed to use problem-specific instructions.

<table>
<thead>
<tr>
<th>Methods</th>
<th>Learning Outcome</th>
</tr>
</thead>
<tbody>
<tr>
<td>i) Excel required without problem-specific instructions</td>
<td>A couple of students completed the work using Excel and the majority complained about lack of Excel knowledge</td>
</tr>
<tr>
<td>ii) Excel optional with problem-specific instructions</td>
<td>Again, two students tried to use Excel, even though problem-specific instructions were available.</td>
</tr>
<tr>
<td>iii) Excel required with problem-specific instructions</td>
<td>Ninety percent of the students use Excel and they follow problem-specific instructions very carefully, or even step by step.</td>
</tr>
</tbody>
</table>

Source: i) and ii) were based on a class in Spring 2011; i) was based on a class in Fall 2011.

Table 3. Implementation Comparison.

The learning outcomes between items i) and iii) in Table 3 indicate that problem-specific instructions encourage students to use Excel for homework problems. Item ii) shows that making Excel optional for homework problems is not an effective way to enhance basic Excel skills, which means we have to make Excel required for as many classes as possible in order to motivate student learning.
We find that the combination of making Excel required for homework problems and providing problem-specific Excel instructions helps student learning in the following three ways. First, we are able to require students to use Excel for homework problems with Excel instructions. In the past (before Excel instructions were developed), students were reluctant to use Excel for selected homework problems even though commercially Excel books or built-in help menus were readily available. Second, while it takes time to develop problem-specific Excel instructions, we feel it is an effective way to enhance basic Excel skills without compromising the required subject contents. As a result, we are able to cover all the required subject topics and at the same time make Excel a required tool in OM101 class. Third, when the list of basic Excel skills expands, students are able to accumulate essential Excel related skills necessary for more advanced business courses and for real world applications.

On a technical aspect, we find that detailed syntax instructions, along with screen snapshots, are as important as the semantics because some students feel that it is easier to follow step-by-step instructions and screen snapshots for the first time with some of the Excel features.

**SUMMARY**

This research tries to enhance basic Excel skills in an undergraduate operations management class in Dolan School of Business at Fairfield University, which helps close the feedback loop identified by the DSB Continuous Improvement Assessment Committee and the DSB Advisory Board. This project serves as a pilot study to explore the feasibility and identify potential obstacles of enhancing basic Excel skills within an existing course without compromising the required subject contents. The experience obtained from this teaching project would be valuable for other business core courses in the Dolan School of Business at Fairfield University.

**REFERENCES**

